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кожного модуля побудована відповідно до логічної струк-
тури виконання певного типу експериментальних навчаль-
но-дослідницьких завдань. Таким чином для кожного типу 
завдань існує свій операційно-пізнавальний евристичний 
модуль, структура якого визначається логічною структу-
рою виконання типового завдання і його конкретним зміс-
том. Модуль висвітлює перед учнем цілі навчально-пізна-
вальної діяльності, логічну структуру виконання даного 
класу експериментальних навчально-дослідницьких зав-
дань. Він вказує, які етапи дослідження повинен пройти 
учень, які прийоми пізнавальної діяльності засвоїти, в чому 
полягає їх зміст і містить евристичні поради і вказівки що-
до їх виконання. 

Усі навчальні елементи, що складають операційно-
пізнавальний евристичний модуль поділяються за змістом 
та дидактичним призначенням на три групи, а саме: органі-
заційні, інформаційні та операційні. 

Організаційні навчальні елементи виконують мотива-
ційну, регулюючу і контролюючу функції щодо організації 
процесу дослідження. В них акцентується увага учня на 
цілеспрямованості дослідження, що сприяє мотивації дія-
льності. Організаційні навчальні елементи конкретно опи-
сують інтегровані цілі дослідження, які учень повинен зро-
зуміти і усвідомити, як особисто вагомий і очікуваний ре-
зультат, а також забезпечують індивідуальний контроль і 
самоконтроль після досягнення мети дослідження в ході 
виконання конкретного експериментального навчально-до-
слідницького завдання. 

 Інформаційні навчальні елементи дозволяють учню 
чітко усвідомити структуру знань про узагальнений об'єкт 
дослідження, логічну структуру виконання типового екс-
периментального навчально-дослідницького завдання, міс-
тять моделі виконання конкретних завдань даного класу, а 
також розкривають суть творчого процесу пізнання в фізи-
ці, окремих наукових методів дослідження на узагальнено-
му методологічному рівні. 

Операційні навчальні елементи модуля спрямовані на 
формування в учнів узагальнених дослідницьких умінь і 
навичок в ході виконання експериментального навчально-
дослідницького завдання. Сукупність операційних навчаль-
них елементів відповідає логічній структурі виконання типо-
вого завдання, тобто кожному етапу дослідження відповідає 
один такий елемент. В ньому вказується, які прийоми дослі-
дницької діяльності, розумові операції повинен виконати 
учень під час даного етапу дослідження. Такий учбовий еле-
мент містить евристичні приписи, поради, узагальнені плани 
дій щодо виконання цих прийомів і операцій. 

Операційно-пізнавальний евристичний модуль не є 
щось інваріантне, незмінне. Це гнучка, адаптаційна струк-
тура як в морфологічному, так і в змістовному плані. Дося-
гається це тим, що, як правило, в структурі модуля є базові 
(інваріантні) навчальні елементи і варіативні (змінювані), 

відношення між якими можуть бути самі різноманітні: змі-
стовні, функціональні, причинно-наслідкові тощо. 

Операційно-пізнавальний евристичний модуль являє 
собою лише загальну орієнтувальну основу виконання тво-
рчого експериментального завдання, яка потребує конкре-
тизації, адаптації до окремо взятого учня, з врахуванням 
його індивідуальних пізнавальних можливостей, а також до 
змісту конкретного творчого завдання, з врахуванням рівня 
його проблемності та складності. Ця проблема вирішується 
за рахунок надання кожному учню в процесі дослідження 
оперативної навчальної допомоги (ОНД).  

Оперативна навчальна допомога може надаватись в 
формі прямих вказівок, допоміжних запитань або допоміж-
них завдань. Прямі вказівки можуть стосуватись різних 
сторін творчої дослідницької діяльності, а саме: змістовної, 
організаційної, операційно-процесуальної, мотиваційної. 
Це стосується також допоміжних запитань. Крім цього, 
допоміжні запитання можуть виконувати також діагности-
чну функцію. 

Використання допоміжних запитань і допоміжних за-
вдань має на меті забезпечити непрямий характер оператив-
ної навчальної допомоги під час виконання учнями окремих 
етапів дослідження. Особливістю допоміжних запитань є те, 
що вони, як і вказівки, завжди спрямовані на одну якусь 
сторону учбової діяльності, тоді як допоміжні завдання охо-
плюють всі чотири сторони. Основною вимогою до допомі-
жних запитань і завдань є те, щоб рівень їх проблемності був 
нижчим за рівень проблемності основного завдання. 
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ПРОГРАМНИЙ ПАКЕТ ORIGIN ЯК ІНСТРУМЕНТ ВІЗУАЛІЗАЦІЇ ДАНИХ  
ФІЗИЧНОГО ЕКСПЕРИМЕНТУ 

У даній статті введені основні поняття пакету Origin, приведений короткий огляд функціональних особливостей да-
ного програмного продукту. Основний акцент зроблений на застосування графічного математичного пакету Microcal 
Origin для обробки результатів та їх графічної побудови.  
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Одним з важливих етапів наукової та дослідницької 
роботи є графічне відображення отриманих результатів. В 
рамках даного програмного пакету, на основі рівнянь або 
даних, що зберігаються у файлі, можлива побудова дво- 
або тривимірних графіків, здійснення перетворень Фур’є, 
згладжування, розкладання кривих по Гаусу і по Лоренцу, 
статистичний аналіз наявної інформації і т.д. 

Перед початком роботи з пакетом Origin необхідно 
зрозуміти основну структуру проекту Origin і пов'язану з 
ним термінологію, а також функціональні можливості па-
кету. Перелічені відомості нададуть допомогу в ефектив-
нішому використанні Origin, для аналізу даних і створення 
необхідної графіки. 
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1. ПРОЕКТ І РОБОЧА ОБЛАСТЬ ГРАФІЧНОГО 
ПАКЕТУ ORIGIN 

Графічний пакет Origin відображає робочий простір, 
який містить (мал. 1): меню; рядок стану; робоче поле; 
інструментальну панель Default (за замовчанням).  

 
Мал. 1. Робоча область пакету Origin з «дочірнім» вікном 

Worksheet 
У графічному пакеті Origin робота організована за 

принципом проектів. Проект Origin подібний до теки фай-
лів: в нього входить набір зв'язаних матеріалів типу графів, 

даних і функцій, пов'язаних з певною темою. Це означає, 
що проект Origin – сукупність «дочірніх» вікон, а також 
наборів даних і змінних.  

«Дочірні» вікна рухомі і змінного розміру. Кожне 
«дочірнє» вікно має власну структуру меню, яка відобра-
жається, коли вікно активне. Наявність «дочірніх» вікон 
дозволяє одночасно розглядати різні візуальні представ-
лення даних, спрощує маніпуляції з даними і їх аналіз. 

При запуску Origin в робочому просторі відкриваєть-
ся вікно Worksheet (за замовчанням програма привласнює 
йому назву Data 1).  

Будь-якому «дочірньому» вікну іншого типу за замов-
чанням так само привласнюється своє стандартне ім'я (див. 
мал. 2). Це ім'я може бути змінене за бажанням користувача. 
Worksheet – один з типів «дочірнього» вікна, доступного в 
Origin, призначеного для введення даних (мал. 1). 

Розглянемо інші типи «дочірніх» вікон: 
Excel (вікно і меню програми Excel); Graph (вікно ві-

зуалізації графіків); Layout (вікно створення нового шару); 
Function (вікно побудови графіка заданої функції); Matrix 
(вікно завдання матриці); Notes (вікно приміток). 

На мал. 2 представлений вид робочої області у разі, ко-
ли всі «дочірні» вікна відкриті. У даному прикладі активним 
є вікно Excel і, відповідно, меню і панель інструментів при-
ймає вигляд, необхідний для роботи в цьому режимі. 

Для створення дочірнього вікна Graph в меню вибе-
ріть пункт File ⇒ New (Файл ⇒ Новий). 

У вікні (мал. 3), що з'явилося, ви-
беріть пункт Graph (Графік).  

 
Мал. 3. Діалогове вікно, що дозволяє вибра-

ти новий об'єкт для роботи 
В результаті робоча область набуде 

вигляду, показаного на мал. 4. Для ство-
рення декількох «дочірніх» вікон одного 
типу досить повторити вищевикладену 
процедуру необхідну кількість разів, тоб-
то якщо, наприклад, необхідно три вікна 
типу Data, досить три рази підряд повто-
рити процедуру File ⇒ New Worksheet. 
Це зауваження відноситься і до створення 
«дочірніх» вікон іншого типу. 

2. ЗБЕРЕЖЕННЯ ПРОЕКТУ 
Для того, щоб зберегти проект з іс-

нуючим ім'ям файлу, виберіть File ⇒ 
Save ⇒ Project. Введіть бажане ім'я фай-
лу в текстове поле (File name), при необ-
хідності вкажіть шлях для запису файлу в 
певну папку і клацніть OK (мал. 5).  

Для збереження проекту з новим 
ім'ям файлу, виберіть File ⇒ Save ⇒ 
Project As. 

При збереженні проекту зберігаєть-
ся вся робота в поточному сеансі. Збере-
жений проект включає всі дочірні вікна, 
що знаходяться на екрані на момент збе-
реження, (включаючи згорнуті), і набори 
даних складових інформацію в дочірніх 
вікнах. Якщо перед збереженням проекту 
яке-небудь з дочірніх вікон було видале-
но, то інформація, що зберігається в цьо-
му вікні, буде так само видалена. 

 
Мал. 2. Робоча область пакету Origin зі всіма відкритими «дочірніми» вікнами 

 
Мал. 4. Робоча область пакету Origin з відкритими «дочірніми» вікнами Worksheet і Graph 
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Мал. 5. Діалогове вікно збереження проекту 

3. ЗБЕРЕЖЕННЯ «ДОЧІРНЬОГО ВІКНА» 
На додаток до збереження проектів існує можливість 

збереження деяких «дочірніх» вікон у вигляді окремих 
файлів. Коли «дочірнє» вікно збережене у вигляді окремого 
файлу, воно може бути відкрите в будь-якому іншому про-
екті Origin. Щоб зберегти активне вікно у вигляді файлу, 
виберіть File ⇒ Save ⇒ Window As. Ця команда меню 
відкриває діалогове вікно Save As. Origin автоматично до-
дає правильне розширення для даного типу активного вікна 
у файл, що зберігається. 

Таблиця 1  
Розширення файлів «дочірніх» вікон  

в графічному пакеті Origin 

Тип вікна Розширення 
файлу 

Project (проект) OPJ 
Graph (вікно візуалізації графіків) OGG 
Worksheet (вікно даних) OGW 
Excel (вікно і меню програми Excel) XLS 
Matrix (вікно завдання матриці) OGM 
Function (вікно побудови графіка заданої функції) OGG 
Notes (вікно приміток) ТXT 

При кожному запуску Origin може відображати тільки 
один проект. Для розгляду декількох проектів одночасно 
необхідно відкрити програму Origin необхідну кількість 
разів, двічі клацаючи на значку програми. 

4. ВІДКРИТТЯ ПРОЕКТУ 
File ⇒ New. Ця команда меню відкриває діалогове ві-

кно New. Виберіть Project із списку (мал. 3) і клацніть OK. 
Origin відкриє новий проект. Якщо який-небудь проект був 
вже відкритий, коли команда меню була вибрана, буде ви-
даний запит про необхідність збереження змін в поточному 
проекті перед відкриттям нового проекту. 

File ⇒ Open використовується для відкриття заздале-
гідь збереженого проекту. Ця команда меню відкриває діало-
гове вікно Open. Виберіть потрібний файл із списку і клац-
ніть OK, щоб закрити діалогове вікно і відкрити проект. 

5. ІМПОРТУВАННЯ ДАНИХ 

Існує декілька способів імпортування даних, по яких 
надалі можлива побудова графічних образів і проведення їх 
математичного аналізу за допомогою пакету Origin. Ми 
зупинимося тільки на двох з них. 

5.1. Введення даних за допомогою клавіатури 
Для введення чисельних значень в таблицю даних 

Worksheet (Data) досить встановити курсор на необхідно-
му елементі таблиці і клацнути лівою кнопкою миші, комі-
рка буде виділена сірим кольором. Після цього можна по-
чинати введення даних за допомогою клавіатури. На мал. 6 
показаний приклад введення даних в «дочірнє» вікно 
Worksheet, комірка B3.  

 
Мал. 6. Приклад введення даних в таблицю Worksheet з клавіатури 

За замовчанням Origin створює вікно Worksheet з 
двома колонками А і В. Щоб додати колонки у вибране 
вікно, необхідно зробити його активним, в основному ме-
ню вибрати функцію Column ⇒ Add ⇒ New Columns. У 
діалоговому вікні, що відкрилося, вказати, скільки колонок 
необхідно додати в Worksheet. 

Вищенаведений спосіб введення даних може бути ви-
користаний при оформленні практикумів, проведенні екс-
периментальних досліджень, що виконуються у відсутності 
автоматичних систем запису результатів експерименту. 

5.2. Введення даних з існуючих файлів 
Origin має стандартний набір засобів для імпортуван-

ня даних різних форматів. Джерелом даних може бути не 
тільки файл, але і різні наукові програми і бази даних. Для 
імпортування даних з одного файлу вибираємо в меню 
команду File ⇒ Import ⇒ Single ASCII. У вікні, що роз-
крилося, знаходимо потрібний файл і відкриваєм його. Дані 
з цього файлу будуть записані в «дочірнє» вікно Work-
sheet, якому буде привласнено ім'я файлу, з якого імпорту-
валися дані. 

6. ПОБУДОВА ГРАФІКІВ 
6.1. Побудова одного графіка в одному «дочірньому» 

вікні Graph 
Для побудови графіка по точках (не стандартній фун-

кції) необхідно в «дочірнє» вікно Worksheet ввести необ-
хідні дані одним з описаних вище способів. Потім в меню 
вибрати команду Plot ⇒ Line. У діалоговому вікні Select, 
що з'явилося, columns for plotting (мал. 7) вибрати необ-
хідну таблицю з даними (у даному випадку це «дочірнє» 
вікно Data1), потім вказати колонку, значення якої відкла-

 
Мал. 7. Приклад діалогового вікна побудови графіка 
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датимуться по осі Х, аналогічно по осі Y і нажимаємо кно-
пку OK. На екрані з'явиться «дочірнє» вікно Graph із зо-
браженням побудованого графіка. 

6.2. Побудова декількох графіків в одному «дочірньому» 
вікні Graph 

Вище був описаний найпростіший випадок побудови 
графіка. Цей алгоритм добре застосовний у разі, коли існує 
одне «дочірнє» вікно Worksheet, в якому дані зібрані тіль-
ки в двох колонках. Розглянемо інші можливі варіанти.  

а) у вікні Worksheet існує декілька колонок з даними. 
Припустимо, колонки А і В, містять дані для одного 

графіка, C і D – для іншого. Тоді, виконавши процедуру 
Plot ⇒ Line, отримаємо діалогове вікно Select columns for 
plotting з відображенням назв для чотирьох колонок. Виб-
равши колонку, значення якої відкладатимуться по осі Х 
(наприклад А), потім по осі Y (наприклад В), клацніть на 
клавіші Add. В результаті цієї дії будуть задані параметри 
для графіку АВ. Аналогічно вибираємо колонки для графі-
ку CD і тиснемо кнопку ОК. У робочій області відобра-
зиться «дочірнє» вікно Graph з двома графіками.  

Для побудови декількох графіків не обов'язково ви-
бирати колонки по порядку, тобто AX, BY, СХ, DY і т.д. 
Можливі випадки, коли, наприклад, даним, що відклада-
ються по осі Х, відповідає тільки одна колонка для всіх 
графіків, а осі Y – всі інші, тоді порядок вибору колонок 
може бути наступним: AX, BY (Add) AX, CY OK.  

б) існує декілька вікон Worksheet (мал. 8), за даними 
яких необхідно побудувати графіки, розташовані в одному 
вікні Graph. Тоді в тому, що з'явилося після команди Plot 
⇒ Line діалоговому вікні Select columns for plotting, необ-
хідно вибрати спочатку Data1 у віконці розташованому під 
написом Worksheet (мал. 7) і визначити, яким колонкам з 
вікна Data1 відповідатимуть значення Х і Y. Потім, в цьому 
ж віконці вибрати Data 2 і вибрати значення Х і Y для ко-
лонок цього вікна. 

6.3. Побудова графіків в декількох «дочірніх»  
вікнах Graph 

Для того, щоб побудувати декілька графіків в різних 
«дочірніх» вікнах Graph в рамках одного проекту, необхід-
но зробити активним спочатку одне з вікон Worksheet, для 
нього вибрати команду Plot ⇒ Line і виконати процедуру 
вибору осей. Потім зробити активним інше вікно Work-
sheet і для нього повторити ті ж дії. 

7. ОФОРМЛЕННЯ ГРАФІКІВ 
7.1. Стиль графіка 

У пакеті Origin існує багато можливостей оформлен-
ня побудованих графіків. Подвійне клацання лівою кноп-

кою миші по графіку викликає діалогове вікно Plot ⇒ 
Details (мал. 9). У даному вікні існує можливість вибору 
стилю (Style), товщини лінії (Width) і так само кольорів 
(Color) графіка. Вибір функції Plot Type відкриває діалого-
ве вікно, яке дозволить створити зображення графіка у 
вигляді різних символів, розмір, колір і форму яких можна 
змінювати. 

 
Мал. 9. Діалогове вікно для створення стилю графіка 

7.2. Редагування осей 
Для редагування осей досить клацнути двічі на осі 

графіка лівою кнопкою миші. З'явиться діалогове вікно, що 
дозволяє задавати різні параметри (мал. 10). 

 
Мал. 10. Діалогове вікно редагування осей графіка 

Виклик діалогового вікна можливий на будь-якій з іс-
нуючих осей. Надалі, у вікні Selection можна вибрати будь-

яку з чотирьох осей, для якої встанов-
люватимуться параметри. 

Вибравши вкладку Scale, можли-
во задати початкове (From) і кінцеве 
(To) значення шкали, а так само крок 
(Increment), з яким на даній шкалі ві-
дображатимуться чисельні значення. 
Вибравши вкладку Title&Format, мо-
жна відобразити на графіці невидимі 
за замовчанням верхню і праву шкали. 
Для цього досить вибрати необхідну 
шкалу у вікні Selection, потім встано-
вити прапорець у віконці Show 
Axis&Ticks і далі визначати бажані 
параметри для вибраної шкали. У цьо-
му ж вікні існує можливість створення 
заголовка для кожної осі Title, а так 
само завдання параметрів вибраної осі, 
таких як товщина, довжина і напрям 
рисок і т.д. 

Зміна шрифту, розміру, кольору і 
стилю заголовка осі можлива при по-
двійному клацанні на одному із стан-
дартних підписів (наприклад X Axis 
Title). 

 
Мал. 8. Вид робочої області з двома відкритими вікнами Worksheet 
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7.3. Створення написів на графіку 
Окрім заголовків осей, часто виникає необхідність 

внесення різних текстових вставок, підписів графіків і т.д. 
Вибір функції Text Tool на панелі інструментів дозволить 
створити необхідний текст на полі графіка. Для цього не-
обхідно клацанням миші виділити кнопку з символом Т на 
панелі інструментів, встановити курсор, що з'явився, на 
місце створюваного напису і клацанням лівої кнопки миші 
викликати діалогове вікно (мал. 11). 

 
Мал. 11. Діалогове вікно створення написів на полі графіка 

8. МАТЕМАТИЧНИЙ АНАЛІЗ 
Origin дозволяє проводити різні види математичного 

аналізу досліджуваних даних. Прості дії над графіками 
проводяться шляхом вибору в головному меню функції 
Analysis ⇒ Simple Math при активному вікні Graph. В 
результаті даної команди в робочій області з'являється діа-
логове вікно Math on/between Data set (мал. 12). У вікні 
Available Data вибираємо назву кривої, над якою необхід-
но провести дію і символом ⇒ направляємо його у вікно 
Y1. Потім на клавіатурі набирається необхідний оператор 
(+, – *, /, ^) і у вікні Y2 вказується чисельне значення, на 
яке потрібно змінити вибрану колонку даних. 

 
Мал. 12. Діалогове вікно математичних дій 

над колонками даних 

У вікні Available Data відображаються назви тільки 
тих колонок, які ідентифіковані як функція Y. Щоб провес-
ти дію над колонкою з «дочірнього» вікна Data1_A, необ-
хідно перепозначити її як А(Y). Для цього у вікні Data1 
клацнути двічі на колонці А. Появиться діалогове вікно 
(мал. 13), в якому у вікні Plot Designation вибрати необхід-
ну функцію. Тут же можна поміняти і назву колонки, її 
ширину, позначення. 

Розглянемо конкретний приклад. Для зсуву графіка 
CD відносно графіка АB уздовж осі Y на 5 одиниць діало-
гове вікно Math on/between Data set повинне виглядати 
таким чином (мал. 14). 

 
Мал. 14. Приклад діалогового вікна математичних дій над колон-

ками даних 
Аналогічні дії можна проводити і безпосередньо над 

колонками. Для цього активним вибирається вікно даних і 
подвійним клацанням виділяється колонка, над якою про-
водитиметься математична операція. У основному меню 
вибирається функція Columns ⇒ Set Columns Values (мал. 
15), в якій можна записувати необхідні вирази для колонки 
B (в даному випадку). Так само однією з необхідних мате-
матичних операцій може бути розкладання графіка на криві 
Гауса або Лоренца. Для цього необхідно, зробивши актив-
ним вікно Graph, вибрати в меню Analysis ⇒ Fit Multi-
Peaks ⇒ Gaussian. З'явиться діалогове вікно Number of 
Peaks, в якому необхідно вказати кількість піків, для яких 
буде виконане розкладання. Курсор, що з'явився, встанов-
люється якомога точніше на одному з піків і фіксується 
подвійним клацанням миші, внаслідок чого з'являється 
вертикальна лінія що позначає положення першого піку. 
Аналогічна процедура проводиться над другим піком.  

Результатом проведених дій є таблиця Results Log 
(мал. 16), об'єднуючи отримані дані про ширину, висоту, 
центри максимумів і площі під кривою. 

9. ПРИКЛАД ВІЗУАЛІЗАЦІЇ ДАНИХ ФІЗИЧНОГО 
ЕКСПЕРИМЕНТУ 

При вивченні курсу «Фізика твердого тіла» магнітні 
властивості твердих тіл посідають значне місце для розу-
міння взаємодій між магнітними моментами атомів. Для 
прикладу покажемо графіки зміни магнітного моменту у 
халькогенідних склоподібних сполуках As2S3 та As2Sе3. 

 
Мал. 15. Вид робочої області при завданні математичних дій над колонками даних 

 
Мал. 13. Діалогове вікно встановлення па-

раметрів колонок 
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Магнітні властивості таких спо-
лук залежать від вмісту домішок атомів 
з великим власним магнітним момен-
том. Питомий магнітний момент, як 
основна характеристика магнітних вла-
стивостей речовини, залежить як від 
величини зовнішнього магнітного поля 
та температури, так і від того, в яких 
умовах здійснюється охолодження зра-
зка. Оскільки, температури досліджень 
дуже малі, то установка для проведення 
цих дослідів обладнана комп’ютером, 
який налаштовується на заданий режим 
вимірювань. 

Вигляд бази даних, знятих з при-
строю, поданий на мал. 17. На мал. 18 
подана залежність питомого магнітного 
моменту сполуки As2S3, легованого 
марганцем 2% ваги в широкому інтер-
валі температур. Така залежність хара-
ктерна для парамагнетиків і є графіч-
ним зображенням закону Кюрі-Вейса. 

На мал. 19 наведені три залежнос-
ті питомого магнітного моменту As2Se3, 
легованого марганцем 5% ваги при 
слабкому зовнішньому магнітному 
полі, коли магнітна взаємодія за вели-
чиною енергії така, як енергія теплово-
го руху атома (kT). Дані мал. 19 свід-
чать про фазовий перехід другого роду 
– перехід з парамагнітного стану до 
феромагнітного [1]. 

ВИСНОВКИ 
Програмний пакет візуалізації да-

них Origin [2] є популярним серед осві-
тян та науковців завдяки своїм широ-
ким можливостям і конкретною спря-
мованістю. Ця стаття може слугувати 
посібником для використання даного 
програмного продукту при вивченні 
тих розділів курсу фізики, в яких доці-
льно застосовувати графічні методи 
пояснення матеріалу для ілюстрації 
порівняльних залежностей між фізич-
ними величинами, що описують проце-
си при зміні будь-якого параметру. 

Оскільки, програмний пакет Ori-
gin використовується, в більшості ви-
падків, для візуалізації даних у науко-
вих дослідженнях, тому є потреба на-
вчитися ним користуватися. 

Список використаних джерел: 
1. Gubanova A., Kryskov Ts., Levytskyi S., Laiho R., Lahderanta 

E. Temperature dependence of magnetic moment of the halko-
genide glasses As2Se3 dopped by manganese depending on size 
of magnetic field. – Abstracts 2nd international conference on 

 
Мал. 16. Вид робочої області з результатами розкладання спектру на криві Гауса 

 
Мал. 17. Вид робочої області з імпортованою базою даних із вказаним режимом вимірю-

вання та графіком залежності 
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Мал. 19. Температурна залежність питомого магнітного момен-

ту As2Se3:Mn 5% у магнітному полі 0,008Тл 
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The basic concepts of Origin package are entered in this 

article, the short review of functional features of this software 
product is resulted. A basic accent is done on application of 

graphic mathematical package of Microcal Origin for treat-
ment of results and them graphic construction.  
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ПРОБЛЕМАТИКА ВИКОРИСТАННЯ МУЛЬТИМЕДІЙНИХ ЗАСОБІВ У ВИКЛАДАННІ ФІЗИКИ 

У статі розглянуто актуальну проблему використання мультимедійних засобів при вивченні фізики. А також можливі 
розв’язки цієї проблеми. 

Ключові слова: мультимедійні засоби, комп’ютер, фізика, застосування. 

У даний час комп'ютер з підключеним до нього прое-
ктором, великим монітором або інтерактивною дошкою 
стає звичним атрибутом кабінету фізики. Це робить більш 
зручнішим викладання для викладача і наочнішим для сту-
дента. По-перше, існує величезна бібліотека малюнків, 
фотографій, таблиць, схем, анімацій, звукових і відеофраг-
ментів, з якої викладач може легко відібрати потрібне для 
кожного заняття і яку легко поповнювати, зберігати (не 
треба шаф з коробками фільмів, стопками таблиць, що до 
того ж вимагають нагляду). По-друге, їх зручно використо-
вувати на занятті: не треба вішати і знімати таблиці, заря-
джати кіноплівку або слайди в проектор, опускати і підні-
мати проекційний екран: все робиться легко одним клацан-
ням миші або пульта, можна легко чергувати різні медіа 
ресурси, робити в потрібний момент зупинки при перегляді 
відеофрагментів. 

Основними завданнями використання мультимедій-
них засобів у викладанні фізики є такі: 

• розвиток творчого потенціалу студентів, їх здібностей 
до комунікативних дій, умінь експериментально-
дослідницької діяльності, культури навчальної діяль-
ності, підвищення мотивації навчання; 

• інтенсифікація всіх рівнів навчально-виховного про-
цесу, підвищення його ефективності та якості; 

• реалізація соціального замовлення, зумовленого ін-
форматизацією сучасного суспільства. 
Використання мультимедійних засобів має врахову-

вати особливості сприйняття інформації та дотримання 
таких принципів: 

1. Багатосенсорне подання навчального матеріалу і 
залучення всіх репрезентативних систем студента, а саме  
сортування основного змісту навчального матеріалу у візу-
альні, аудіальні та кінестетичні категорії з метою визна-
чення пріоритетної форми подання матеріалу і викорис-
тання найбільш ефективних технік та прийомів впливу на 
репрезентативні системи. 

2. Вивчення нового матеріалу, організація тренінгу, 
тестування та здійснення перевірки і контролю успішності 
його засвоєння. 

Але існує небезпека надмірного захоплення мульти-
медійними засобами на заняті: 

1) втрата первинного інтересу. Самі по собі ці засоби 
тільки спочатку можуть привернути увагу студентів, заці-
кавити їх, що збільшить їх активність і віддачу на занятті, 
але потім вони звикаються й ефект зникає; 

2) перевага традиційних засобів наочності у ряді ви-
падків. Може виявитися необхідним, наприклад, повісити 
паперову таблицю, щоб вона була перед очима студентів 
весь урок. Багато схемних малюнків корисно малювати 
викладачу на дошці – послідовно, з поясненням, копіюван-
ням дій студентами; 

3) хворобливе захоплення багатими можливостями 
засобів презентацій. 

Багато картинок, схем, анімацій можна і потрібно за-
мінити звичайним усним описом, показом демонстрацій, 

проведенням лабораторних робіт. Навіщо використовувати 
мультимедійні засоби, якщо ці досліди ми можемо провес-
ти в звичайних умовах. На прикладі цієї адреси в Інтернеті 
http://fiziks.org.ua/wp-content/uploads/2007/07/pod_uglom.swf 
ми можемо побачити, що даний продукт не є потрібним в 
навчанні фізики. І що його дуже легко (і набагато краще) 
відтворити на лабораторній роботі з більшим коефіцієнтом 
засвоювання та розуміння. На нашу думку, багато існую-
чих флеш-анімацій з фізики не несуть в собі особливої не-
обхідності для використання. 

На сучасному етапі в нашій країні рядом дослідників 
і, зокрема, нами проводиться пошук раціональних методик 
використання мультимедійних засобів в процесі вивчення 
фізики. Однією з існуючих методик передбачається фраг-
ментарне використання комп’ютера, іншою – проведення 
занять, на яких надання нового матеріалу та контроль за 
його засвоєнням проводиться мультимедійними засобами. 

На нашу думку, фрагментарне використання мульти-
медійних засобів у викладанні фізики є найбільш вдалим 
його впровадженням. Тому що при повній передачі управ-
ління навчальним процесом мультимедійним системам 
(подання нового матеріалу, закріплення знань, контроль та 
оцінювання) втрачається творчість у викладанні предмету. 
За своєю суттю фізика – наука творча і потребує інженер-
но-творчого підходу до її вивчення (викладання). Якщо ж 
викладання (вивчення) фізики звести до загальнорепродук-
тивного за допомогою мультимедійних технологій, втрача-
ється сам сенс фізики. Комп’ютери ніколи не зможуть за-
мінити компетентного фахівця, і роль мультимедійних 
засобів, на нашу думку, є тільки допоміжна в навчанні фі-
зики, а не основна. 

Тому доцільність використання мультимедійних за-
собів під час вивчення фізики полягає в наступному: 
• ілюструвати пояснення викладача, даючи при цьому 

більш повну і точну інформацію про явище, яке вивча-
ється; 

• поліпшити наочність, створивши уявлення про меха-
нізм складних для розуміння явищ і тим самим полег-
шити їх засвоєння; 

• спостерігати і аналізувати досліди та процеси, спосте-
реження яких в умовах навчальної лабораторії усклад-
нене; 

• ознайомити з фундаментальними фізичними експери-
ментами, проведення яких ускладнене або неможливе 
(з огляду на дотримання правил техніки безпеки, висо-
кої вартості обладнання або його габаритні розміри), 
наприклад, дослід Герца, Столєтова та ін.; 

• навчити правил користування фізичними приладами та 
проведенню вимірювань фізичних величин в процесі 
виконання експериментальних задач на визначення від-
носного показника заломлення скла, вимірювання дов-
жини світлової хвилі за допомогою дифракційної реші-
тки та ін.; 

• підвищувати якість та ефективність проведення навча-
льного фізичного експерименту;  

• навчати розв’язувати фізичні задачі, як якісні, так і 
розрахункові; 


